<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>1.1 Getting Started</td>
<td>3</td>
</tr>
<tr>
<td>1.2 Contacting Us</td>
<td>4</td>
</tr>
<tr>
<td>1.3 FAQ</td>
<td>4</td>
</tr>
<tr>
<td>1.4 Purchase SewArt</td>
<td>5</td>
</tr>
<tr>
<td>1.5 Videos</td>
<td>5</td>
</tr>
<tr>
<td>2. Menus</td>
<td>5</td>
</tr>
<tr>
<td>2.1 File menu</td>
<td>5</td>
</tr>
<tr>
<td>2.2 Edit menu</td>
<td>6</td>
</tr>
<tr>
<td>2.3 View menu</td>
<td>6</td>
</tr>
<tr>
<td>2.4 Tools menu</td>
<td>7</td>
</tr>
<tr>
<td>2.5 Options menu</td>
<td>8</td>
</tr>
<tr>
<td>2.6 Window menu</td>
<td>8</td>
</tr>
<tr>
<td>2.7 Help menu</td>
<td>9</td>
</tr>
<tr>
<td>3. File commands</td>
<td>9</td>
</tr>
<tr>
<td>3.1 New</td>
<td>9</td>
</tr>
<tr>
<td>3.2 Open</td>
<td>10</td>
</tr>
<tr>
<td>3.3 Close</td>
<td>11</td>
</tr>
<tr>
<td>3.4 Save</td>
<td>12</td>
</tr>
<tr>
<td>3.5 Save As</td>
<td>12</td>
</tr>
<tr>
<td>3.6 Print Patterns</td>
<td>14</td>
</tr>
<tr>
<td>3.7 Exit</td>
<td>14</td>
</tr>
<tr>
<td>4. Edit commands</td>
<td>14</td>
</tr>
<tr>
<td>4.1 Undo</td>
<td>14</td>
</tr>
<tr>
<td>4.2 Cut</td>
<td>14</td>
</tr>
<tr>
<td>4.3 Copy</td>
<td>15</td>
</tr>
<tr>
<td>4.4 Paste</td>
<td>15</td>
</tr>
<tr>
<td>5. View commands</td>
<td>16</td>
</tr>
<tr>
<td>5.1 Toolbars</td>
<td>16</td>
</tr>
<tr>
<td>5.2 Large Toolbar icons</td>
<td>16</td>
</tr>
<tr>
<td>5.3 Application Look</td>
<td>16</td>
</tr>
<tr>
<td>5.4 Grid</td>
<td>16</td>
</tr>
<tr>
<td>6. Tools commands</td>
<td>17</td>
</tr>
<tr>
<td>6.1 Crop</td>
<td>18</td>
</tr>
<tr>
<td>6.2 Rotate</td>
<td>20</td>
</tr>
<tr>
<td>6.3 Reflect</td>
<td>20</td>
</tr>
<tr>
<td>6.4 Resize</td>
<td>20</td>
</tr>
<tr>
<td>6.5 Posterize</td>
<td>21</td>
</tr>
<tr>
<td>6.6 Wizard</td>
<td>23</td>
</tr>
<tr>
<td>6.7 Reduce Colors</td>
<td>28</td>
</tr>
<tr>
<td>6.8 Merge Colors</td>
<td>30</td>
</tr>
<tr>
<td>6.9 Paint Brush</td>
<td>35</td>
</tr>
<tr>
<td>6.10 Pencil</td>
<td>37</td>
</tr>
<tr>
<td>6.11 Bucket Fill</td>
<td>39</td>
</tr>
<tr>
<td>6.12 Eraser</td>
<td>42</td>
</tr>
<tr>
<td>6.13 Shapes</td>
<td>43</td>
</tr>
<tr>
<td>6.14 Convert to Redwork</td>
<td>46</td>
</tr>
<tr>
<td>6.15 Convert to Stitches</td>
<td>46</td>
</tr>
<tr>
<td>6.16 PAS Editor</td>
<td>52</td>
</tr>
<tr>
<td>7. Options commands</td>
<td>53</td>
</tr>
<tr>
<td>7.1 Grid</td>
<td>53</td>
</tr>
<tr>
<td>7.2 Units</td>
<td>53</td>
</tr>
<tr>
<td>7.3 Parity</td>
<td>54</td>
</tr>
<tr>
<td>7.4 Canvas</td>
<td>54</td>
</tr>
</tbody>
</table>
7.5 Language Support ........................................................................................................... 54
8. Window commands .............................................................................................................. 54
  8.1 New Window .................................................................................................................... 54
  8.2 Cascade ........................................................................................................................ 54
  8.3 Size ................................................................................................................................ 54
  8.4 Tile .................................................................................................................................. 55
  8.5 All Windows .................................................................................................................... 55
9. Help commands .................................................................................................................. 55
  9.1 Help Topics ..................................................................................................................... 55
  9.2 Auto-Update ................................................................................................................... 55
  9.3 Update Now .................................................................................................................... 55
  9.4 About SewArt ................................................................................................................. 55
  9.5 Change (History) Log ..................................................................................................... 55
  9.6 Context Help .................................................................................................................. 55
10. Digitizing Topics ............................................................................................................... 56
  10.1 Blank Canvas ................................................................................................................ 56
  10.2 Change Fill Pattern ...................................................................................................... 56
  10.3 Change Paint Tool Color .............................................................................................. 56
  10.4 Remove Speckles ......................................................................................................... 57
  10.5 Resize or Change Density ............................................................................................... 59
  10.6 Transparency Color ..................................................................................................... 59
11. Toolbars ............................................................................................................................ 60
  11.1 Main Toolbar ................................................................................................................ 60
  11.2 Palette Toolbar .............................................................................................................. 61
  11.3 Status Bar ...................................................................................................................... 61
  11.4 Stitch Toolbar ............................................................................................................... 62
  11.5 Satin Toolbar ............................................................................................................... 66
  11.6 Workspace ................................................................................................................... 67
12. Sew commands .................................................................................................................. 68
  12.1 Auto Sew Color ............................................................................................................ 69
  12.2 Auto Sew Image .......................................................................................................... 69
  12.3 Fill .................................................................................................................................. 69
  12.4 Var-Satin ...................................................................................................................... 69
   12.4.1 Satin Stitch: Basics ............................................................................................... 69
   12.4.2 Quad Covering ....................................................................................................... 70
   12.4.3 Edit Stitches ............................................................................................................ 73
   12.4.4 Open Curve ............................................................................................................ 74
   12.4.5 Closed Curve ......................................................................................................... 75
   12.4.6 Angles (Bends) ..................................................................................................... 77
   12.4.7 Overlapping Points ............................................................................................... 78
   12.4.8 Complex Shapes - Branching ............................................................................... 80
   12.4.9 Disjoint Parts ........................................................................................................ 83
  12.5 X-Stitch ........................................................................................................................ 84
  12.6 Outline .......................................................................................................................... 84
  12.7 Appliqué (border) .......................................................................................................... 84
  12.8 Appliqué (centerline) .................................................................................................... 85
  12.9 Add Appliqué to Embroidery File ............................................................................... 85
  12.10 Underlay ..................................................................................................................... 86
Introduction

1.1 Getting Started

A Tutorial for Digitizing Images with SewArt

**SewArt** is software for converting digital graphics images - which may be stored either in raster (bitmap) or vector format - to a *stitch* file that can be sewn on an embroidery machine. For a list of image formats that **SewArt** can read, see [File Open](#). This process will be referred to as *embroidery digitizing* and the software for doing that (**SewArt**) is called an *auto-digitizer*.

It is advisable to familiarize yourself with the **SewArt** *workspace* and the associated toolbar buttons. Most of the important operations for the conversion process are accessible by clicking these buttons. The key to obtaining a high-quality embroidery file is to first create an image comprised of uniformly-colored regions. For that reason, **SewArt** has numerous image-processing tools on its toolbar to help in creating images suitable for sewing. Such images will be called *clean images*.

The steps below outline the general procedure for using **SewArt** to convert a digital image into an embroidery file. By clicking the following links in order, you can follow the step-by-step process of image conversion, starting from an image file and ending with an embroidery pattern file. When using this help in such a tutorial fashion, remember to click on the *Home* symbol at the top right of each subtopic page to return to this main page and then proceed to the next step.

**Steps for converting a digital image to an embroidery file**

**Step 1.** From the File menu, click **Open** (or from the Edit menu, **paste** from the clipboard) to *import* the graphics image to be converted. You may also draw your own graphic image on the *blank canvas*.

**Step 2.** If the image is a photograph (jpg, gif) then it may be helpful to **posterize** it (eliminate subtle color gradations) before proceeding. Vector clipart images generally can skip this step since they already are segmented into solid-color regions.

**Step 3.** Click on the image processing **wizard** toolbar button. This will guide you through a sequence of steps designed to further reduce color numbers and blend speckles (that lead to erratic sewing) in a controllable fashion.

**Step 4.** Use individual graphics editing tools to process the image to make it suitable for sewing. There are three groups of image processing tools, described below:

**A. Size and position tools**
- **Resize** the image. This allows you to work with an image of the same size as the embroidery pattern size to be sewn.
- **Rotate** the image (by 90-degree increments) if it is more conveniently viewed in a different orientation.
- **Crop** the image if it has excessive white space around it. Working with a smaller image is usually easier.

**B. Color reduction tools**
- **Reduce** the number of colors in the image.
- **Merge** and despeckle colors individually or in specified ranges based on the amount of area in the image covered.

**C. Image editing tools**
All these tools can also be used in conjunction with the magnifier to allow editing of very localized regions of the image.

- Use the paintbrush to fill (blend) small regions of isolated pixels or gaps in the image
- Use the pencil to darken lines and fill individual pixels in the image
- Bucket fill larger regions of the image to uniformly blend colors and avoid any fine-scaled (dithering) effects.

**Step 5.** Save the edited graphic image to a file on disk

**Step 6.** Convert the graphics image to stitches by clicking on the different color regions to be sewn, possibly using the auto-sew feature, and save the stitch list to an embroidery pattern file. You may edit entries in the stitch list or right-click a color stop to delete it or insert another stop before it in the list. The next region clicked will be entered at the inserted stop. SHIFT-Left-Click a stop to reposition it in the stitch list.

**Step 7.** Edit the embroidery file to join or reorder color blocks, or eliminate short thread runs (this can be done with an embroidery editor, such as SewWhat-Pro©).

### 1.2 Contacting Us

If you have any questions or comments about the SewArt auto-digitizing application, please contact us at the following support email:

support@sandscomputing.com

### 1.3 FAQ

**Frequently Asked Questions**

**How To . . .**

- Avoid Sewing the Background Color
- Change the color of a painting tool
- Change the fill pattern
- Get help if you have questions about SewArt
- Purchase SewArt
- Remove outlier points to create an image suitable to be sewn
- Resize or change the density of a design created by SewArt
- Undo a previous operation
- Use a "Blank Canvas" to draw your own images

Some frequently asked questions about SewArt are answered below:

*How can I tell if I have the latest version of Sew Art?*
Go to the Help/About menu item and compare the version there with the one that is available for download on our website. You can use the Update button to go to our website and check there for the most recent version.

*Can I install SewArt on more than one computer?*
The license grants you the privilege to install on one desktop and one laptop, as long as you are the sole user of SewArt on all the computers.
How do I put a copy of SewArt onto a laptop that has no internet capability?

Transfer the installer file (the file you downloaded originally) onto the laptop, using a USB or other transferable drive. Then double-click that file on the laptop and enter your registration information. Alternatively you can purchase SewArt on a CD.

If my computer crashes, how do I get SewArt working again?

You can download the latest version of SewArt from the S & S website at http://www.sandscomputing.com

Just download from the SewArt INSTALL button there. It is a good idea to keep a copy of your registration information in a separate, safe location.

SewArt Menus

- File menu
- Edit menu
- View menu
- Image menu
- Options menu
- Window menu
- Help menu

1.4 Purchase SewArt

You may purchase SewArt from the Shop page of the S & S website:

http://sandscomputing.com/products-shop/

or any of our reseller websites. Click the Add-to-Cart button on the Shop->SewArt webpage to purchase the license. If you want to order a CD, use the down-arrow on the Add-to-Cart button to select the CD version of the software.

To update to the latest version of the software, use the Download button on the Shop->SewArt webpage of our website.

There is a 30 day DEMO period during which you may evaluate the software at no cost. The only restriction during the evaluation period is that at most 3 colors will be saved to the converted embroidery files. Once the DEMO has expired (or sooner), you can either uninstall the software or purchase a license (Add-to-Cart). If you purchase the license, registration information will be emailed to you and you can register the DEMO to make it a licensed copy with no restrictions. You DO NOT have to uninstall the DEMO if you want to keep the software, but only register it after receiving the license information.

1.5 Videos

Video tutorials for SewArt can be found and viewed at this location (videos) on our website. Scroll to the "videos" button to open the carousel.

2. Menus

2.1 File menu
The File menu offers the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new blank sewing pattern file.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an existing sewing pattern file.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the presently active pattern file.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves an opened image file, using the same file name.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves an opened image file to a specified file name.</td>
</tr>
<tr>
<td>Print Patterns</td>
<td>Prints a catalog of all the patterns available with pattern numbers and names</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the SewArt application.</td>
</tr>
</tbody>
</table>

2.2 Edit menu

The Edit menu offers the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Reverses (undo) previous editing operation.</td>
</tr>
<tr>
<td>Cut</td>
<td>Cuts (deletes) part of image in selection rectangle</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies (for drag/drop operation) part of image in selection rectangle</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes an image from the Windows clipboard into the SewArt workspace.</td>
</tr>
</tbody>
</table>

2.3 View menu
The View menu offers the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars and Docking Windows</td>
<td>Shows or hides the main toolbar.</td>
</tr>
<tr>
<td>Large Toolbar Icons</td>
<td>(or reduce) the size of the icons on the main toolbar</td>
</tr>
<tr>
<td>Application Look</td>
<td>The consistent appearance of toolbars and dialogs</td>
</tr>
<tr>
<td>Grid</td>
<td>Displays a grid for accurate positioning of the image</td>
</tr>
</tbody>
</table>

2.4 Tools menu

The Tools menu offers the following image-manipulation commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate</td>
<td>Rotate image in 90-degree increments</td>
</tr>
<tr>
<td>Reflect</td>
<td>Reflect (mirror) image left to right</td>
</tr>
<tr>
<td>Crop</td>
<td>Remove unwanted areas of an image for easier editing.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resize</td>
<td>Resize image to width of desired embroidery pattern</td>
</tr>
<tr>
<td>Posterize</td>
<td>Posterize (cartoonize) an image</td>
</tr>
<tr>
<td>Wizard</td>
<td>Starts image-processing wizard</td>
</tr>
<tr>
<td>Reduce Colors</td>
<td>Reduce number of distinct colors in image</td>
</tr>
<tr>
<td>Merge Colors</td>
<td>Merge and despeckle individual colors (or range of colors) in the image</td>
</tr>
<tr>
<td>Paint Brush</td>
<td>Blends existing colors</td>
</tr>
<tr>
<td>Pencil</td>
<td>Fills in single pixels or lines</td>
</tr>
<tr>
<td>Fill Region</td>
<td>Fills in a large region with a uniform color</td>
</tr>
<tr>
<td>Eraser</td>
<td>Erases parts of the image</td>
</tr>
<tr>
<td>Shapes</td>
<td>Add various shapes to canvas or image</td>
</tr>
<tr>
<td>Convert to Redwork</td>
<td>Converts the graphics image to redwork pattern</td>
</tr>
<tr>
<td>Convert to Stitches</td>
<td>Converts the graphics image to an embroidery pattern file</td>
</tr>
<tr>
<td>PAS Editor</td>
<td>Creates and edits Programmable Stitch (PAS) files</td>
</tr>
</tbody>
</table>

2.5 Options menu

The Options menu offers the following commands for setting project options:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>Choose grid spacing, line thickness and color</td>
</tr>
<tr>
<td>Units</td>
<td>Choose to use metric or Imperial units of length</td>
</tr>
<tr>
<td>Parity</td>
<td>Choose between left- and right-handed tool icons</td>
</tr>
<tr>
<td>Canvas</td>
<td>Select Default Width and Height for Blank Canvas</td>
</tr>
<tr>
<td>Language Support</td>
<td>Select the language for this <strong>SewArt</strong> session</td>
</tr>
</tbody>
</table>

2.6 Window menu
### The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the application window:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new window that views the same document.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Arranges windows in an overlapped fashion.</td>
</tr>
<tr>
<td>Tile</td>
<td>Arranges windows in non-overlapped tiles.</td>
</tr>
<tr>
<td>Windows</td>
<td>Goes to specified window.</td>
</tr>
</tbody>
</table>

### 2.7 Help menu

The Help menu offers the following commands, which provide assistance for using **SewArt**:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help topics</td>
<td>Offers you an index to topics on which you can get help.</td>
</tr>
<tr>
<td>Auto Update</td>
<td>Allow (if checked) or prevent automatic daily checking for updates.</td>
</tr>
<tr>
<td>Update Now</td>
<td>Checks the website for available updates and updates automatically.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td></td>
</tr>
<tr>
<td>About SewArt</td>
<td>Displays program information, version number and copyright.</td>
</tr>
<tr>
<td>Change (History) Log</td>
<td></td>
</tr>
</tbody>
</table>

### 3. File commands

#### 3.1 New
Use this command to create a new document workspace for opening a new blank canvas. You can open an existing image with the Open command.

**Shortcuts**

<table>
<thead>
<tr>
<th>Toolbar:</th>
<th>Keys:</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder icon]</td>
<td>CTRL+N</td>
</tr>
</tbody>
</table>

### 3.2 Open

Use this command to open an existing graphic file in a new window. You can open multiple files at once, and each will occupy a separate window. Use the Window menu to switch among the multiple open images.

**SewArt** will allow you to open several raster file types (*.bmp, *.png, *.jpg, *.gif, *.tif) as well as vector formats (*.emf, *.wmf). When you use this command, **SewArt** displays a file open dialog so you can select the pattern file(s) to open.

Alternatively, you can open an existing document by selecting it from the most recently used (MRU) file list in the File menu, if it was recently opened.

The figure below shows a preview of the image file *Penguin130X130.png*. (This image is used for the tutorial with permission from Clipartpolis. It is available for use with this tutorial in the Samples folder of the SewArt installation folder. It is advisable to copy this file to another folder with write privilege before you begin using it for this tutorial.) The image is surrounded by a bounding rectangle which shows the editable region of the image. We have chosen a (raster) PNG file because it illustrates many of the necessary image reduction features that **SewArt** can apply. Beginning users might consider using simpler vector graphics files that are available for free download - and without copyright restrictions - from several websites. They will require less image manipulation to produce a suitable image for sewing.
If you have graphics files in formats that are not currently supported by SewArt, you can import them into SewArt by using the Edit menu paste command.

You can create a new blank workspace “canvas” with the File New command.

**Shortcuts**

**Toolbar:**
- Desktop
- Libraries
- This PC
- Network

**Keys:** CTRL+O

### 3.3 Close

Use this command to close all windows containing the active document. SewArt suggests that you save changes to your document before you close it. If you close a document without saving, you lose all changes made since the last time you saved it. Before closing an untitled document, SewArt displays the file save-as dialog and suggests that you name and save the document.

**Shortcuts**

You can also close a document by using the Close icon on the document’s window (upper right of the workspace screen), as shown below:
3.4 Save

Use this command to save both image files and stitch files. Which one gets saved depends on the active mode of operation of **SewArt** at the time the Save command is issued.

1. For any **SewArt** mode except the stitching mode, **Save** will write the edited image to either a compressed image (png) file or a Windows bitmap (*.bmp) file. When you save a document for the first time, **SewArt** displays the **File Save As** dialog so you can name your image file and select the type to save to.

2. When **SewArt** is in **Stitch Mode**, **Save** will write the stitches you have created to an embroidery pattern file. You may choose from one of three popular file formats Brother® (*.pes), Janome® (*.jef) or Singer® (*.xxx): (This can be converted later in an embroidery file editor to whatever convenient format you need.) Along with this embroidery file, a file containing the stitch list information will also be saved with the extension *.saf. When you reopen the image file at some later time, the previous stitch listed can be loaded, too. The first time that **Save** is used from **Stitch Mode**, **SewArt** will display a special form of the **File Save As** dialog to allow you to choose the name for the pattern file and select its format and its size (if it should be different from the image size).

3.5 Save As

In **SewArt**, the **Save As** command performs a dual role, depending on the active mode at the time the command is issued.

1. When **SewArt** is in any mode except for the **Stitch Mode**, use this command to save and name the image as either a compressed image file (*.png), Tagged Information File (*.tif), or a Windows bitmap (*.bmp) file. Best results (in terms of preserving color content and minimizing file size) is usually obtained saving to TIF format. **SewArt** displays the standard file save-as dialog box so you can name your image file and select its type. It is **strongly** recommended to save using the *.png (portable network graphics©) format, which compresses the file by as much a 100 times, compared to the *.bmp bitmap format.

2. When **SewArt** is in **Stitch Mode**, use this command to save and name the stitch pattern file (see the dialog below). Both the File name and its type (*.pes, *.jef, or *.xxx) can be set here. In addition there are two further options that effect how the pattern file is saved:
• **Design Scale Factor** for scaling the pattern file relative to the image file. The pattern size will be displayed next to the box where you enter this numerical factor. A value larger than 1.0 will create a pattern file larger than the image file, and vice versa.

• **Minimum Stitches in a Color Block** that SewArt will stitch out to the pattern file. The default is 4. Color blocks in the pattern with fewer than this number of stitches will not be sewn.

• **Join Adjacent Same-Colored Threads** can be checked (the default) or unchecked. When checked, same-colored threads (blocks) in the image thread list will be automatically joined when they are written out to the pattern file. This is desirable to limit the number of thread stops in the embroidery file.

• **Select Thread Brand for Color File:** use this combo drop-down box to select the thread manufacturer use to write out the color text file associated with the saved embroidery file.

To save an image or a pattern file with its existing name and directory, use the **Save command**.

**Shortcuts**

Toolbar:
3.6 Print Patterns

Use this command to print a catalog of the various patterns available as fill stitches in SewArt.

3.7 Exit

Use this command to end your SewArt session. You can also use the Close command on the application Control menu. SewArt prompts you to save documents with unsaved changes.

Shortcuts

Mouse: Click the application’s Exit (close SewArt) menu button.

Keys: ALT+F4

4. Edit commands

4.1 Undo

Use this command to reverse the last editing action, if possible. Important: The Undo command is dimmed on the menu or toolbar (it is unavailable) if there are no actions to reverse or if you are in Stitch Mode. In SewArt, the following operations may be undone (the last several - usually up to 10 - operations can be reversed this way):

<table>
<thead>
<tr>
<th>Undo Operation</th>
<th>Effect of Undo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Restores the delete part of the image</td>
</tr>
<tr>
<td>Copy</td>
<td>Removes the copied image area</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotate image by -90 degrees</td>
</tr>
<tr>
<td>Resize</td>
<td>Restore image to previous size</td>
</tr>
<tr>
<td>Reduce Colors</td>
<td>Restore previous number of colors</td>
</tr>
<tr>
<td>Merge Colors</td>
<td>Restore color state prior to merge</td>
</tr>
<tr>
<td>Paint Brush</td>
<td>Erase last paint operation</td>
</tr>
<tr>
<td>Pencil</td>
<td>Erase last pencil click (or line drag)</td>
</tr>
<tr>
<td>Bucket Fill</td>
<td>Erase last filling operation</td>
</tr>
</tbody>
</table>

Shortcuts

Toolbar: 

Keys: CTRL+Z

4.2 Cut
Use this command to delete the part of the image inside the selection rectangle. This command is unavailable (dimmed out) if a selection rectangle has not been dragged out in the workspace.

This command deletes part of the image. For example, if your image is a two-eyed, two-horned flying purple people eater and you want a one-eyed, one-horned one, select one of the eyes (and one of the horns) by dragging your mouse over those items (with the left button down). Release the mouse button and click this menu item to delete the selected part of the image.

The deleted part(s) of the image is placed on the clipboard so you can Paste it back and move it somewhere else if you wish.

**Shortcuts**

**Toolbar:**

**Keys:** CTRL+X

**4.3 Copy**

Use this command to copy a part of the image for a subsequent Paste operation. This command is unavailable (dimmed out) if a selection rectangle has not been dragged out in the workspace.

This command copies the selected part of an image for later duplication. To select a portion of the image, hold down the left-mouse button and drag out a *selection rectangle* around it. Then press the Copy toolbar button (or Ctrl+C shortcut key) to copy the selection to the Clipboard. After copying, you can paste and move the duplicated part of the image to another location in the SewArt workspace.

**Helpful Note:** You can drag the selected part of the image even without copying it to the clipboard. This is an easy way to duplicate an image and saves the steps of copying and pasting. If you find you no longer need the copy, just press the Delete key to remove it while it is still selected. Copying to the clipboard is a more general operation, in that the image you copy will be available for use in other SewArt image files, too (not just the current workspace).

**Shortcuts**

**Toolbar:**

**Keys:** CTRL+C

**4.4 Paste**

Use this command to insert a graphic of an image that was copied to the clipboard from either another application (like MS® Paint) or from the SewArt workspace. This command is unavailable (dimmed out) if the clipboard is empty.

This command may be used to copy (or merge) an image from a file type that is not supported by SewArt into an empty or existing workspace. Parts of the image that have been Cut or Copied can be pasted as well. Pasted objects appear in the upper right corner of the workspace,
and appear with a selection rectangle around them. To move them, you must click inside the selection rectangle and move the pasted object to the desired location.

### Shortcuts

**Toolbar:**

**Keys:**  
CTRL+V, SHIFT+INS

---

5. View commands

5.1 Toolbars

Use this command to display and hide the main toolbar, which includes buttons for some of the most common commands in SewArt, such as File Open. A check mark appears next to the menu item when the Toolbar is displayed. It is checked by default.

5.2 Large Toolbar icons

Use this menu item to toggle the size of the icons on the main toolbar.

5.3 Application Look

Use this menu item to change the appearance of the toolbar and dialog panes. Several application appearance choices are available (see below). Several Office 2007 choices will appear by clicking on the chevron. The style displayed throughout this help manual is the Office 2007, Silver Style.

- Windows 2000
- Office XP
- Windows XP
- Office 2003
- Visual Studio 2005
- Visual Studio 2008
- Office 2007

5.4 Grid

When checked, this command displays a grid on top of the image.

In the tutorial figure below, the penguin image is shown with the grid option checked and the grid spacing set to 5 mm. The presence of the grid is useful for editing individual pixels or regions of an image with the Paint Brush or Pencil tools, and for drawing lines to fill-in borders and boundaries.

The grid is drawn on top of the image on the screen and will not be sewn.
6. Tools commands
6.1 Crop

Use this toolbar command to crop (remove) parts of the image or to expand the image space to paste additional components from the clipboard. For example, if there is excessive white space around the image that need not be sewn, it can be cropped with this tool.

After clicking this toolbar button, a moveable and resizable cropping-rectangle will appear surrounding the image. (See figure below.) Drag the corner or side handles to resize the rectangle, and click the rectangle and drag to move it to the desired position. When the part of the image you wish to retain appears inside the cropping rectangle, press the *End Crop* button in the Crop Mode pane to perform the cropping operation on the image and return to normal editing mode. If the cropped image is *not* what you wanted, press *Ctrl-Z* (or click the Edit/Undo menu item) to reverse the cropping operation.

The tutorial example in the figure below (which can be found in the SewArt/Sample folder) shows the cropping rectangle (grayed out line) around the original image. The width of the cropping rectangle has been reduced to fit tightly around the image. When the *Close* button ("x" at top right of Crop mode box) is clicked, or when the Crop toolbar button is toggled off, it will eliminate the white space outside the image (the translucent region will be cropped out).

At this point, it is advisable to *Save* the edited image file. Since cropping has reduced the image width from 130 to 110 mm, we save it to a compressed image file called *Penguin110X130.png*. 
If you are using this help as a tutorial, click on the Home button (upper right) to return to the main page.

**Shortcuts**

**Toolbar:**
6.2 Rotate

Use this toolbar command to rotate the image in 90-degree increments for easier viewing. If you are using this help as a tutorial, click on the Home button (upper right) to return to the main page.

Shortcuts
Toolbar:

6.3 Reflect

Use this toolbar command to reflect the image about a vertical line (left to right). If you are using this help as a tutorial, click on the Home button (upper right) to return to the main page.

Shortcuts
Toolbar:

6.4 Resize

Use this toolbar command to open a dialog (shown below) for resizing the image. This is a useful option if you want to work in SewArt with an image of comparable size to the final stitched pattern.

![Resize Image dialog](image)

The present size of the image will appear initially in the Width (265 mm for this example) and Height (265 mm) boxes. Edit these by entering the desired sizes for the image (in mm). If the Lock Aspect Ratio option is checked, then you only need to edit one or the other of these items and the other will be updated to keep the original height-to-width ratio (the aspect ratio of the image).

If you wish to return to the previous size, press Ctrl-Z to Undo this operation.
If you are using this help as a tutorial, click on the Home button (upper right) to return to the main tutorial page.

**Shortcuts**

**Toolbar:**

### 6.5 Posterize

Use this toolbar command (or menu item) to **posterize** (or **cartoonize**) an image. **Posterization** of an image occurs when a region of an image with a continuous gradation of color tone is replaced with several regions of fewer tones, resulting in abrupt changes from one tone to another. This generally reduces the number of distinct colors and speckles in an image. (This is in contrast to **color reduction** quantization alone, which preserves many fine-scale features of an image.) Posterization produces broad solid color areas of an image which are ideally suited for stitching.

Posterize Mode opens a set of three slider control that can be independently adjusted to control the degree of despeckling, contour smoothing, and posterization applied to the image. See Fig. 1, which shows the *SewArt* workspace in Posterize Mode. The sliders can be dragged from 0 (no effect) towards 1 (maximum effect) to see the impact on the image. The optimal levels are image-dependent and depend on the effect desired. Default values of 0.5 and 0.4 for the despeckle and smoothing values are used, with no posterization applied (value of 0).

In Posterize Mode, a thumbnail of the *original image* will automatically appear in the upper right corner of the image workspace. This makes a comparison with the modified image easier. The thumbnail can be resized or moved at your convenience by dragging on its resize handles or clicking/dragging on the resize rectangle.
Figure 1: Posterization Mode showing an enlarged thumbnail of the original jpeg image (right) and the posterized image (left) for the default settings.

For the photograph (PNG file) of a tiger shown in Fig. 1 (which was imported from MS Word ClipArt and is in the SewArt/Samples folder), the thumbnail has been enlarged to make the effects of posterization more apparent. This original image would be very tedious to stitch because of all the small-scale color gradations (for example, the individual hairs and whiskers on the tiger), and would lead to very poor quality of the stitch-out.
After the default despeckling and feature blending were applied (displayed in the image on the left, where the color count has been reduced from 256 to 156), there is less continuous gradations of color and more solid color regions which can be more easily converted to stitches. Some of the very fine-scale details has been sacrificed (such as individual whiskers and hairs), but these would generally not sew-out well anyhow.

The color number can be further reduced to 46 without any degradation of the image (see Fig. 2) by either increasing the posterization level to 0.70 or by reducing the number of palette colors directly.

Figure 2. Reducing the color number to 49 by increasing the posterization level to 0.70 has little impact on the quality of the image.

**Shortcuts**

**Toolbar:**

**6.6 Wizard**

Use this toolbar command to enter the Wizard mode. This starts the image-processing wizard to guide you through the steps to convert the image into a form amenable for a high-quality stitch-out.

The basic principle of the Wizard is to choose various values (color numbers, despeckling or merge
percentages) in a way that will both reduce the color number and preserve the image integrity. There are up to eight selections per page. To leave the image unchanged click the "Original Image" radio (selection) button and then proceed to the next Wizard page.

Each page of the Wizard (after the introduction) allows you to perform a different image-processing operation as noted in the caption title bar. The Wizard has navigation buttons at the bottom of each page to allow you to proceed to the next page (the Next button), to return to a previous page (the Back button), or to Cancel the Wizard and return to the main SewArt screen. Note that any operations performed in the Wizard mode may be undone when you have returned to normal mode.

There are 4 steps (distinct types of processing) performed by the Wizard and described below. At each step you may choose from one of up to 7 reduction values (including the option to keep the unprocessed image). The choice is guided by the basic principle stated above: try to choose the value closest to the end of each list (which produced the biggest image processing effect) which leaves the visual integrity of the image intact.

**Step 1: Color Reduction**

The Wizard dialog for this case (we use the Penguin bitmap example, with 246 colors initially, throughout this discussion) is shown above. After reducing the color number a few times, one arrives at an image which is no longer acceptable (see figures below).
Note that the two-tone color of the penguin bill has disappeared. So the 61 color button was clicked, leading to an acceptable image. The Next button was then clicked to proceed to the next page of the Wizard. (NOTE: the color numbers shown on this dialog depend on the number of initial colors in the image. Also, the color numbers specified are only target values and the final reduction is only guaranteed to be equal to or less than the number clicked. In this case, clicking 61 colors yields 56 colors in the processed image. If the Back button would be clicked from the next page, the color numbers would then be based on 56 colors and not the original 246.)

Step 2: Merge Colors

The Wizard dialog for this case is shown below:

In this case, the list of percentages represent the fractional coverage in the image required before a color will be merged. The 0.40% button was clicked, indicating that colors that cover no more than 0.40% of the image area were merged. Even with this small percentage coverage, the image deteriorated so that it was unacceptable (see Figure below):
In particular the merge from 56 colors to 15 colors leaves most of the image intact but the outline of the bill began to disappear. (Note that the apparent discoloration of the cap is due to reducing the size of the figure and does not actually occur in the full-size image.) Thus, the 0.20% button was clicked to maintain the image integrity, while reducing the color number to 20.

Step 3: Remove speckling

The Wizard dialog for this case is shown below:

In this case, pressing the lowest available color coverage fraction (1.56%) already produced an unacceptable image (see below), where the thin dark contours were broken up by the despeckling operation:
This is unusual and due to the graininess of the thin, dark outline contours. A much more typical case would be for a substantial color fraction (50-100%) to be despeckled without any noticeable degradation of the image. For this case, the thin outline colors were individually merged once the image-processing Wizard completed. Therefore, it was necessary at this step to click the "Original Image" radio button on the present Wizard page and then move to the next and final Wizard page.

**Step 4: Final Image Processing**

The Wizard dialog for this case is shown below:

![Wizard dialog](image)

This final step presents the opportunity to do a "clean-up" of any remaining small-coverage colors. In this case, clicking the 0.78% button gave an acceptable image with a further color reduction to 12 colors:
While most of the solid black outline is preserved by this final processing, some of the outlines in the cap seem to break up. We nevertheless chose to accept this reduction (by clicking the "Finish" button). Once the Wizard was finished, we were able to merge a thin layer of yellowish pixels from the merge dialog, thus recovering the black outlining in the cap. If this had not been possible, we would have undone (Ctrl-Z) this last processing step.

Once you have finished these Wizard steps, you may want to view the individual colors of the image in the Merge utility. In particular, make sure all the speckling has been removed, before trying to sew out the image.

**Shortcuts**

**Toolbar:**

6.7 Reduce Colors

Use this toolbar command to reduce the number of distinct colors in the image. The color reduction is done through the same sophisticated color quantization process that SewArt uses to reduce the potentially 16 million image colors (in a 32-bit display) to only 256 when the image file is opened. This tool, in conjunction with color merging, provides the capability to smooth small-scale color variations in the image which would be very difficult to sew-out well.

Why is color reduction important when converting an image to stitches? Below is a 10-fold magnification of the tutorial file penguin130X130.png (which originally had 246 distinct colors). Many of these colors are barely distinguishable shades of the seven or eight different solid colors that are clearly visible in the (unmagnified) image. For example, note the various shades of blue in what appears to be a solid blue region, particularly at the boundaries between the blue and the other colors. If each of these shades were stitched as a separate color, there would be many small, disconnected regions. That will lead to a very low quality embroidery stitch-out. The goal of the color reduction tools in SewArt is to reduce these small variations and create a solid region that can be sewn in a single color shade without distorting the visual appearance of the image.
When the *Reduce Colors* toolbar button is clicked, the *Image Color Reduction* dialog box appears (see the figure below). Enter the desired number of colors for the image in the edit box. In this example, the initial 246 colors were changed in a series of steps. (In order to maintain the appearance of the image, it is best to reduce the colors in steps.) Typically, halving the number of colors is a good way to proceed. In this case, the image color number was reduced from 246 to 128 to 64, without any substantial change in the image appearance. Reducing the colors to 32 removed some of the essential color variation, so *Ctrl-Z (undo)* was used to restore the color number to 48 (for this image, *SewArt* reduced the final color number to 42 even though a *maximum* of 48 was requested.

It is interesting to ask: what happened to the other 204 colors (remember there were 246 colors originally)? The answer is they have been color-merged ("quantized") with the remaining colors to form the final visible, approximately solid color regions. As noted above, this reduction is important for the eventual uniform sewing of the image.

If you are using this help as a tutorial, click on the Home button (upper right) to return to the main page.

**Shortcuts**

*Toolbar:*
6.8 Merge Colors

Use this toolbar command to further decrease (after applying the reduce color tool) the number of distinct colors in the image by merging colors that are very close to each other in appearance (i.e., close in Red-Green-Blue color space). This dialog also has a despeckle button which removes speckles (scattered, generally unconnected points). An example of image despeckling, and how it differs from color merging, is presented in the speckle removal topic.

When the merge toolbar button is clicked, a list of all the colors appearing in the image will be presented in the Merge Mode pane (just below the information pane on the right of the SewArt workspace). The label under each button is the percentage of the image area covered by each color. See the Fig. 1A below which displays the 42 colors in the tutorial example (after color reduction was applied).
As a first step toward further color reduction, you can click the **Merge Range** button to open the dialog below:
You can select the value (in percent) of the color coverage to merge. All colors with an image color coverage *below* the specified percentage will be merged when the OK button is clicked. Choosing the default value (0.50%) and clicking "OK" results in the reduced palette below (13 colors) with essentially no degradation in the image quality:
Fig. 1B Color Merge-Despeckle dialog after range merge performed.

The merge and despeckle buttons are disabled until you click one (or several, by holding down the Control key) of the color buttons. When you click on a color button, the part of the image covered by that color is highlighted. (**Note**: this is a **toggle** operation - if you click the same color
button twice in a row, the original complete image will reappear.) In the Figure 2a below, the orange color was clicked (4.86% coverage as shown in the Merge Mode pane), corresponding to the penguin's lower bill, mouth and feet, and then the yellow color (1.30% coverage), corresponding to the penguin's upper bill. Obviously these are solid color features which should be retained as part of the image to be sewn: that is, they should not be merged since they are distinctive features of the image.

The remaining orange and yellow color stops display very low coverage percentages. Clicking on the orange button with 1.55% coverage will show (in addition to the solid upper bill) a barely discernable, diffuse pattern of scattered points that tend to follow the outline of the well-defined features in the image in Fig 2a (see Fig 2b). Such points arise because of the imperfect color quantization of a real JPG image and would generally be absent in vector clipart images. These speckles, or diffuse unconnected points, must be eliminated from the image, since they would not sew smoothly. Indeed, the embroidery needle would have to jump from one unconnected point to another, which is undesirable. They should therefore be discarded by blending them with the higher-percentage colors.

The process of removing speckles is called despeckling. It can be accomplished by clicking the Despeckle button. When a particular color button has been selected (or a group of colors is selected by holding down the Control key when clicking the colors), then only the highlighted color(s) will be despeckled. Parts of the selected color can be selectively despeckled by moving the cursor over those parts and clicking over those areas. The cursor changes to a rectangular despeckle-tool when it hovers over the selected color, with a size that can be controlled by right-clicking and selecting from three available sizes (see Fig. 3) Otherwise, the despeckling operation can be applied to a range of colors in the entire image (by clicking the Despeckle button). Note that in contrast to the merge operation (described in the next paragraph), despeckling blends the speckles with the local neighboring colors. In contrast, merging a color will change all the points of the color to a single existing color which is closest in RGB space. If the result of the despeckle blending is unacceptable, it can be undone by clicking the Undo toolbar button or entering Ctrl-Z.
Fig 3. Menu to select the size of the despeckle tool.

Low coverage speckles may also be eliminated by clicking on a color button to activate the Merge button. Then clicking the Merge button will merge the chosen color with an existing color resulting in a decrease in the number of colors by 1. Also, the color button will become inactive (dimmed) corresponding to the elimination of that color from the pattern. If for some reason the effect of this merge is unacceptable, it can be undone by clicking the Undo toolbar button (or Ctrl-Z).

If you desire control over which color the chosen one is merged with (Merge will automatically determine the nearest color in RGB space to the selected one), you can hold down the Shift (or Ctrl) key when you click the color button to be merged. Then, the next color button that is clicked will be the one that is used for the merge. This extra control might be useful in the following circumstance: suppose one of the colors consists largely - but not entirely - of a solid region, but has some speckles as well. This is fairly typical, with the speckles following a boundary between two colored regions of the figure. Then, you could use the Bucket Fill tool to fill the solid region with a slightly different color. When Merge Mode is entered, you will have two color buttons of nearly the same color, one with a relatively high percentage coverage (corresponding to the solid region that was just bucket-filled) and one with a low percentage coverage corresponding to the speckles that you wish to merge. Hold down the Shift key and select that speckle color button and then click on a color (usually black, but not always) corresponding to the solid boundary that you wish to merge the speckles with. Note that a simple Merge button click would not have worked in this case: it would have simply re-merged the speckles with the solid color region!

After completing the merge operations, click the Merge button again (toggle it) to exit Merge Mode. At this point in the image editing process, it is advisable to Save your changes, possibly renaming the file at the same time so you have a record of all the changes made.

If you are using this help as a tutorial, click on the Home button (upper right) to return to the main page.

Shortcuts

Toolbar:

6.9 Paint Brush

Use this toolbar command to draw on the image workspace with a colored brush. After pressing this toolbar button to activate Paintbrush Mode, the cursor will change to a paint brush whenever your mouse is in the active workspace. The paint brush tool options appear in the Paint Brush mode pane (see the Figure below), which opens on the right of the workspace below the main toolbar and above the palette bar.
You may select different properties for the brush: free-hand strokes, constrained lines; or filled rectangle or ellipse. These latter brush operations are useful for filling larger areas in a single click, and for drawing figures on a blank canvas. The usual application of this command is to fill in gaps or blend small regions with the brush color. You may reverse a paint operation by pressing Ctrl-Z to Undo it.

There are several ways to select the brush color: control-click on a region of the image; click on the palette bar at the bottom of the SewArt workspace; or click on the eye-dropper tool and drag it over the image and click on the desired image color.

To perform the actual brushing, hold down the left mouse button while dragging the brush to blend that color into the region of the image. The tip of the brush is the hot spot where the drawing occurs. The width of the brush can be chosen by clicking on one of the line-width buttons. In the figure above, a blue color has been chosen and the selected line-width has a dotted rectangle around it. Note that the size displayed on the screen for the brush width will depend on the magnification (zoom) that is in effect during the blending procedure.
To exit Paintbrush Mode, click on the paint brush toolbar button again (toggle it), click on the “x” in the upper right corner of the Paintbrush mode pane, or click any one of the other available toolbar buttons.

If you are using this help as a tutorial, click on the Home button (upper right) to return to the main page.

Shortcuts

Toolbar:

6.10 Pencil

Use this toolbar command to draw lines, rectangular and elliptical outlines, and free-hand points with a colored pencil (see figure below). To change the pencil color, hold down the Control key and click on a region of the image, or click on the color palette at the bottom of the SewArt workspace screen. You can also use the eye-dropper icon to select a color. Either click the left mouse button to draw individual points with this color, or drag the pencil to draw a line or border with the chosen color.

The default width of the pencil is one pixel. Its appearance on the screen depends on the chosen magnification zoom level. Click one of the line width buttons to create a pencil up to 8 pixels wide. The yellow solid rectangle button shown in the figure below indicates both the width and color of the pencil. When using the pencil tool, it may be convenient to magnify the region being edited until individual pixels can be viewed.
Drawing with the pencil can be done either in free-hand mode, or in one of the constrained modes used to create straight lines, rectangular or elliptical outlines.

The usual application of this tool is to fill in individual points (isolated outliers) with the dominant color of the chosen region, or to straighten and/or thicken lines in the image. When drawing on the blank canvas, the pencil is useful for free-hand sketching or drawing lines and outlines. The pencil complements the paint brush and can be used where very small (pixel-size) details of the image need to be adjusted. To erase lines entered with the pencil, press Ctrl-Z to Undo the last drawing operation.

The button Thicken Lines can be used to thicken thin lines in the image. First choose the desired thickness by clicking on one of the Pencil Width options.

To exit Pencil Mode, either re-click the pencil toolbar button (toggle), click the "x" in the upper right corner of the Pencil mode pane, or click one of the other available buttons on the toolbar.

**Shortcuts**

**Toolbar:**
6.11 Bucket Fill

Use this toolbar command to uniformly fill a region with a solid color. After clicking this button to activate Fill Mode, you may choose the fill color in several ways (see Fig. 1):

1. Click the eye-dropper icon and drag the resulting cursor with your mouse onto the part of the image containing the desired color. Click that region with the eye-dropper cursor to select that color for the fill.

2. Hold down the Ctrl-key and click on the color in the image to use for the fill.

3. Click on one of the pre-defined palette colors appearing at the bottom of the workspace screen.

4. Create your own custom fill color using the hue-saturation-luminance (HSL) picker tool. Drag the little square to a part of the Hue-Saturation square and then adjust the luminance slider. The resulting RGB color value will appear below the square.

In either case, the bucket fill color will appear below the Color Matching Tolerance slider (which will be described below). To reverse a recent fill, press Ctrl-Z to Undo it.
Figure 1. Bucket fill mode showing the tutorial image.

After selecting the fill color, the cursor automatically changes to a bucket when you move the mouse into the image workspace. Click the bucket (left mouse) to "pour" a fill color into the region of the image over which the tip of the bucket hovers. For example, if the bucket is over the white background, this can be used to distinguish the background area of the image -
which generally is not sewn - from regions in the image (like the white vest of the penguin) that should be sewn. This same method may be used to change one or more of the image colors.

An advanced application of this command is to fill (blend) small color variations within a relatively large region of the image where paint-brushing may be too slow or prone to error (for example, at the boundaries of the region). Typically this would be done after color reduction and color merging were already applied to the image. This blending effect requires that you select a non-zero color matching (or blending) tolerance. Move the color matching tolerance slider from 0% upwards (gradually) towards 100%, then click the bucket tool in the desired region. Gradually increase the tolerance percent until the bucket fill yields the desired degree of blending. Increasing the tolerance too much will cause the bucket fill to bleed into adjacent areas. If this undesirable effect occurs, then press Ctrl-Z immediately to recover the previous unblended state.

An example of advanced "tolerance-assisted" filling is shown in Fig. 2. (This example is not taken from the tutorial example which has no regions demonstrating this effect):

Figure 2. Tolerance fill to reduce dithering

The top image shows a region of a GIF file. Note the cross-hatching (dithering) in the brown region, which is undesirable for stitching since it would cause a tremendous amount of jumping from one thread location to the next. The bottom image was obtained using the bucket tool, using the following steps: 1) the eye-dropper was dragged over the top image and the desired brown color was selected; 2) the tolerance slider was incremented up to 40% (this was determined by trial and error - it may be a different value for different images); and 3) the bucket tool dragged over the same area and clicked. Note that now all the very small-scale color variations have been removed, and the brown region would now be considered suitable for stitching with SewArt since it is uniformly filled with a single solid (brown) color. Bucket fill blending is sometimes a useful alternative to color reduction, at least for small regions of the image. Figure 3 shows the effect of bucket filling on the tutorial image, without (left) and with (right) tolerance blending. On the left, the (default aqua) bucket fill tool was clicked on the right part of the penguin's beanie with the blending tolerance set to zero. (It has been recolored to aqua for purposes of this tutorial, but in practice the fill color would be subsequently changed back to the original wine color.) Note that the fill is irregular since there are small-scale variations in color of the original image. This shows very clearly why some form of reduction or blending is required prior to sewing the image: otherwise the irregular (aqua) colored region would be stitched rather than the desired smooth full upper 1/3 of the beanie.
Figure 3. Tolerance fill for the beanie cap region of the tutorial example.
The right image in Fig. 3 shows the effect of bucket filling after setting the tolerance to 20%, and then clicked the bucket tool on the same region again. Now the entire 1/3 part of the beanie has been uniformly filled with the same solid color. As a result, this region is ready to be stitched.

To exit Fill Mode, re-click the bucket toolbar button or click one of the other available toolbar buttons.
If you are using this help as a tutorial, click on the Home button (upper right) to return to the main page.

Shortcuts

6.12 Eraser

Use this toolbar command to erase parts of the image. After clicking this button to activate Eraser Mode, you may choose the eraser size (see the figure below). The cursor will change into an eraser when it is dragged over the image. Hold down the left mouse button to erase the part of the image under the eraser. You can choose the eraser color either from the image itself by using the eyedropper tool, or from the color palette at the bottom of the workspace screen. Unlike the Pencil and Paintbrush tools, eraser size does NOT change when zooming in or out. This means you can erase very small, selected areas of the image by zooming in to a particular region with the Zoom tool.
Eraser Mode

Click this toolbar button again to exit Eraser Mode, or click the "x" in the upper-right corner of the Eraser mode pane.

6.13 Shapes

Use this toolbar command to add various shapes to an existing image or blank canvas. Clicking this button enters SewArt into Shapes Mode. Shapes created with this editor exist in a separate image layer and can only be edited while the Shapes editor is open. Once this mode is closed - either by clicking the shapes toolbar button again (to toggle it off) or clicking another toolbar button - all the shapes entered during the editing session become part of the image and can be removed by the usual Undo (Ctrl-Z) mechanism.
Note that all shapes entered during the current editing session will be removed by a single *Undo* operation.

New shapes may be pasted into the image by clicking on one of the shape icons in the Shapes editor (see figure below). The fill color of the active (selected) shape can be changed by using the dropper tool to select a color in the image or by clicking on one of the colors in the palette toolbar at the bottom of the workspace. The active shape may be rotated by increments of 1 degree by clicking on the spin control above the “Rotation Angle” label.
While in *Shapes Mode*, shapes can be edited by clicking on them. A selection rectangle appears around the shape which then can be moved, resized, and/or deleted (press the **Delete** key). The selection rectangle will disappear when you click outside the shape or click on another shape or exit *Shapes Mode*. Note that the currently-selected shape will automatically be on top of all other shapes. This means if two (or more) shapes overlap, the top-most one will be the last one to be selected.
6.14 Convert to Redwork

Use this toolbar command to convert the image to a redwork outline, that can be saved to an embroidery file by later clicking the convert to stitches button. When you click this button, the options menu shown below will pop-up:

You can choose Outline to convert a filled image into outline stitches. Choose the Centerline option if the image is already outlined. Note that this option will preserve (and thin down to a single pixel) existing outlines in the figure. For example, if you have created a stick-figure using the drawing tools in the Blank Canvas, you would want to use centerlining to convert the image to an outline.

After selecting the appropriate option, the image will be automatically converted to outlines or center-lines. The resulting "redwork" image can be edited with the pencil or paintbrush tools to either remove unwanted segments of the drawing, or to add to (or connect existing parts of) the image. When you are ready to save the redwork image to an embroidery file, click the Convert to Stitches toolbar button to open the outline toolbar.

If you want to create your own redwork image from a blank canvas, then you should click this button before beginning to draw. This will avoid splitting single thin lines into parallel pairs of lines.

6.15 Convert to Stitches

Use this toolbar command to convert the image to stitches which can be saved to an embroidery file in several popular embroidery file formats: Brother® (*.pes), Janome® (*.jef), Husqvarna® (*.hus), Pfaff® (*.vip), or Singer® (*.xxx).

When you click this button, the Stitch Toolbar will appear, indicating that SewArt has entered Stitch Mode. From the stitch toolbar you control properties of the stitches in any region of the image that you want to sew, including the stitch angle, presence or absence of underlay, fill pattern and stitch length. (If the image is a Redwork image, then you can select the type of outline stitches to use. The remainder of this topic describes the steps needed to convert a filled
image to stitches. For use of the Outline and Appliqué options, see the Stitch Toolbar for more information.)

SewArt does not support a satin stitch for area-filling the image. However, you can choose from a variety of pattern fills as described below. You may set these properties from the toolbar and/or edit them in the stitch list after the image has been sewn. Also, the cursor will change to a "sewing needle" when you are over the image. If you have previously sewn and saved this image and have reopened it, you will be asked if you want to import the existing stitch list. If you answer "yes," all the stitches from the previous session of SewArt for this file will be restored. You can clear the current stitch list by clicking the Clear Stitches button. This clearing operation cannot be undone.

Follow the steps below to perform the actual conversion of the digital image to an embroidery pattern file. Refer to the Fig. 1 as needed. It shows SewArt in Stitch Mode, and the associated color stops entered into the stitch list (the right tool info pane). The colors sewn in the image are shown hatched. The "Auto-sew Image" button was clicked and the white background was chosen as the transparency color not to be sewn.
You may end a sewing session at any time by clicking the **End Sew Mode** button. If you have not saved the stitches to a file, you will be asked to do so at that time. Even if you decline, the stitches will be retained in memory for the current session of SewArt, so these stitches will be
retrieved the next time you enter *Stitch Mode* but before closing this work session. However, the stitches will be *permanently saved only* if you decide to *save* them before closing *SewArt*.

There are just two steps involved in converting the image into stitches that are saved in an embroidery file:

1. **"Stitch" the Image (on screen)**
   The process of converting the image into stitches is very simple in *SewArt*. You can choose between completely manual stitching (which gives you the most control), auto-sewing an entire color, or auto-sewing the entire image. These options are described here:

   1. **Manual stitching**: click on a region of the pattern that you want sewn. The point you click - the *seed point* - will show up as a colored rectangle on the screen. You can change the type of pattern fill by first selecting the new pattern fill from the drop-down box and the clicking again on the region to be refilled. The new pattern fill will appear. If you know the number of the pattern fill, you can also edit that in the stitch list in the row of the color you wish to change. Also, you can add an outline stitch to a filled region by first changing the stitch type to an outline (or appliqué) and then click again on that region.

   2. **Auto-sew Color**: click the *Auto-sew Color* check box on the toolbar. Then click a color and *all* disconnected regions of the image with that color will be sewn.

   3. **Auto-sew Image**: click the *Auto-sew Image* check box on the toolbar. A drop-down menu will appear with a choice to sew all colors (including the background) or to choose a *transparency* color that will *not* be sewn. Once you made this selection and chosen the transparency color if required, stitching of the image will begin automatically.

   **Important Note**: use the auto-sew options with some care. Unless the image is *clean* (in the sense that it contains few outlier points), auto-sew could take considerably longer than manually clicking on the individual color regions. If there are numerous outlier points - which are barely visible and which make a negligible contribution to the image quality - the auto-sew option will nevertheless have to check each of those points.

   You may want to edit certain features of the auto-sewn pattern before saving it - see the section below that describes how to edit the stitch list.

2. **Save the Embroidery Pattern and Stitch List**
   Click the *Save* button on the main toolbar to write the contents of the stitch list to an embroidery file. This will open a *File Save As* dialog for you to enter the file name if the file was not previously saved in this session. There is an option to enter a scale factor in the *Design Scale Factor* box, which allows you to adjust the size of the pattern as a multiple of the image size. The default value (1.0) means the embroidery file size will be the same as the image size you are editing. The aspect ratio (width-to-height ratio) of the sewn pattern will be the same as that of the image regardless of the value of the scale factor. You can choose the minimum number of stitches to be sewn in any color block (the default is 10).

   After saving the stitches to the embroidery file, you may continue editing the image or adjusting the pattern parameters in the stitch list. If for any reason you decide to end your stitching session, click the *End Sew* button. If you have made any changes to the stitch list, you will be asked to save them at this time.
If you save the pattern and stitch list, the next time you open the image file in SewArt you will have the option to read in that information to continue further editing of the stitches, as described below.

Congratulations! You have now converted your image into an embroidery file!

Once you have created the stitch list as described in step 1 above, and before proceeding to saving it as an embroidery file in step 2, you may want to edit the stitch list. Editing can also be done after the image conversion is complete and you have viewed the image in an embroidery editor. If for any reason you want to modify the embroidery file you created, just reload the stitch list into SewArt and apply some (or all) of the editing features described below.

Choosing the starting point ("seed") for sewing
When you click the left mouse button, the tip of the "sewing needle" cursor defines the starting point (seed) from which SewArt will fill that region with stitches to match the image color. A judicious placement of the seed will minimize jumps in the final stitching.

For example, it is advisable to choose an extremity of the region - far left or right, top or bottom - so sewing can proceed in one direction only. You should never choose a seed in the middle of the region! To obtain the best sew outs, the thread should flow in one direction for each section (region) of the embroidery design. For a region, click the tip of the "needle" cursor at the farthest point perpendicular (at right angles) to the chosen stitch angle. Sewn regions are identified as showing hatched "threads" instead of a solid color fill.

Figure 2 shows the seed point as the red dot (where the tip of the needle cursor was clicked). The cursor was clicked at the farthest point and at 90° to the angle chosen in SewArt (a 45° angle was used for this example.) The underlay stitches at 90° to the chosen angle. Note that the embroidery stitches flow away from the red dot (seed point) in one continuous direction to the other side of the region.

![Image of 45° stitch angle](image)

Figure 2. Schematic of the Stitch Angle setting, showing a 45° angle for the fill stitch.

Often the recommended angles to use are the diagonals (45°, which is the same as -135° and is shown in Fig. 2, or -45°, which is the same as 135°) which avoid the weaker points at the top, bottom and sides of the hooped fabric where the fabric is more likely to give (pull away from the hoop). However, other angles may be more appropriate when trying to produce a textured appearance (for example, similar objects arranged on an arc). The stitch angle range in SewArt is conveniently chosen to be from -90° to +90°.

Different sides of an odd-shaped region can be tested to find the best angle to use. Use the resew option (see below) to restitch as required.
After the clicked region has been sewn, continue to click on other regions of the image until all parts of the image you want in your final embroidery pattern are "sewn" in this manner.

**Pattern Fill**
Click on the scroll arrow of the pattern fill combo box to select a pattern fill to use for the fill stitch. This will drop-down a list of available fill patterns to choose from. Use the up-down arrows to scroll through the patterns. An image of the selected pattern will appear next to the fill list. Click on one of these patterns to make it the active pattern that will be used the next time an area of the image is stitched. You can click on the Print Pattern (File menu) menu item to print a catalog of all the available fill patterns.

**Pull Compensation**
Sometimes large area fills can cause different parts of the pattern to literally pull apart when sewn. (This depends on the material and backing used.) For this reason, a small pull compensation (or offset) can be added to individual patterns (the "Pull" column in Fig 1.) As a default, a value of "2", corresponding to a pull offset of 0.2 mm in the direction of the fill, is added to all fills. This can be adjusted up (to 4-6) for larger area fills, or down (0-1) for smaller area fills, depending on whether any gaps between adjacent fills need to be closed.

**Edit the Stitch List**
At any time during the stitching process, you may edit the values in the stitch list (such as the stitch angle, length, underlay and fill settings). Just click on the item in the list and type in the modified data. Tabs and arrow-keys can be used to easily navigate through the list to the item(s) to be edited. For example, suppose you stitched the pattern initially so that all stitches are at the same angle. Before the final pattern file is saved, you can change angles for different parts of the pattern. To do this, click on the appropriate angle entries in the stitch list and edit them by entering the desired values. Note that angles are measured from the horizontal line (which is the default, or 0°). Thus, an angle of 90° corresponds to stitches in the vertical direction.

**Helpful hint:**
A contiguous range of stitch property values can be changed to the same value by clicking one of the header buttons at the top of the stitch list. For example, suppose the image was stitched with Underlay on (checked) for all parts of the pattern. But there are some thin outlines in the image that do not require (and indeed should not have) underlay. Click on the U-L (underlay) column header button and a dialog box will pop-up allowing you to enter the range of color stop numbers, and the value (either "Y" for underlay, or "N" for no underlay). Clicking OK will then automatically change all the underlay values in the entire range.

**Delete or Insert Color Stops**
To see which sewn region of the image corresponds to one of the color stops in the stitch list, click that color stop button to highlight the associated part of the image. A pop-up menu will appear with options to Delete that color (from the stitch list, not from the image), or to Insert another color stop before the one that was just clicked. You can re-click on any region to sew it out again after making any modifications. If the insert (before) option is selected, a "blank" black color block will be inserted before the active color stop. The next image area that is clicked will be placed in that position in the stitch list. This may be useful if you want to add a particular part of the pattern somewhere other than at the end of the stitch list. Ignore this pop-up (by clicking on the Close menu option) if you do not want to perform any of these operations.

**Move Color Stops**
To move a color stop to a different position in the stitch list, hold down the Shift key and left-click the color stop. Then drag (by holding down the left mouse button while moving the cursor) the color stop to the position in the list you want to place it, and drop it (by releasing the mouse
button). Color stops that are dragged up (towards lower color stop positions) will be placed above the stop they are dropped on, and vice versa for stops that are dragged down.

**Shortcuts**

Use this toolbar command to open the PAS Creator/Editor application (Fig. 1) used to edit existing (or create new) Programmable Stitch files (PAS files).

Programmable stitches appear in the pattern fill drop-down box on the stitch toolbar. They are used by SewArt to select the stitch points for filling a pattern. In Fig. 1, an existing PAS file ("S & S.pas") has been opened for editing. The "Motif View" displays how the resulting stitch points would appear in an area fill. After finishing any changes to the design, be sure to Save them before closing the editor.

New PAS images can also be created (File->New) and saved. You can click free-hand shapes or use the Edit->Paste option to paste an image from the clipboard into the editor workspace to use as a "template" for the new PAS shape. With the left mouse button, click new points using the template as a guide. For example, you might import your company logo and then click around that to create a new pattern fill with that shape.
7. Options commands

7.1 Grid

Use this menu item to choose the separation, line thickness and color for the optional grid used in SewArt. The grid may be toggled on or off in the View menu.

7.2 Units
Use this menu item to choose between metric and Imperial (American) units of measure in SewArt.

### 7.3 Parity

Use this menu item to choose between left-handed and right-handed tool cursors in SewArt.

### 7.4 Canvas

Use this menu item to select the default width and height (inches) for the blank-canvas opening screen in SewArt. This is particularly useful if you are creating your own image with the pen and brush tools. The canvas will be automatically resized whenever an image is imported into SewArt.

### 7.5 Language Support

Click this Options menu item to select the language used for this SewArt session. You must download the language support resources file (DLL) from the SewArt webpage and put it in the SewArt folder on your computer.

### 8. Window commands

#### 8.1 New Window

Use this command to open a new window with the same contents as the active window. You can open multiple document windows to display different parts or views of a document at the same time. If you change the contents in one window, all other windows containing the same document reflect those changes. When you open a new window, it becomes the active window and is displayed on top of all other open windows.

#### 8.2 Cascade

Use this command to arrange multiple opened windows in an overlapped fashion.

#### 8.3 Size

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

**Note:** This command is unavailable if you maximize the window.

**Shortcut**

**Mouse:** Drag the size bars at the corners or edges of the window.
8.4 Tile
Use this command to arrange multiple opened windows in a non-overlapped fashion.

8.5 All Windows
SewArt displays a list of currently open document windows at the bottom of the Window menu. A check mark appears in front of the document name of the active window. Choose a document from this list to make its window active.

9. Help commands
9.1 Help Topics
Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step instructions for using SewArt and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.

9.2 Auto-Update
Use this toggle command to allow (prevent) automatic updating of SewArt software. When this menu item is checked (unchecked), auto-updating is allowed (prevented). With auto-updating allowed, the S & S website will be checked whenever the application is opened (but not more than once daily) for available updates. If there is an update available, the user will be given the opportunity to install it. The installation will automatically close the SewArt workspace, remove the older version, install the update, and restart the application.

9.3 Update Now
Use this command to search the S & S website at any time for the availability of an update for SewArt. If an update is found, the user is given a choice to install it.

9.4 About SewArt
Use this command to display the copyright notice, version number and registration information for your copy of SewArt.

Shortcuts
Toolbar:
9.5 Change (History) Log
Use this command to view a log file of all the changes made to SewArt during its development.

9.6 Context Help
Use this command to obtain context-sensitive help for toolbar and menu items. When you (single left) click this toolbar button, the cursor changes to a “?” icon. Then click on the item for which you want help, and the help manual will open to an appropriate topic.
Shortcuts

Toolbar:

10. Digitizing Topics

10.1 Blank Canvas

When SewArt opens, the workspace contains a 100 X 100 mm image called a blank canvas. If you want to create your own artwork to sew, you can use the paintbrush, pencil and bucket tools to draw and color images on the "canvas". You may save your artwork and convert it to stitches like any other image.

The balloon below was created (by someone with limited artistic ability!) using the paintbrush to create a solid red ellipse. Note that when "writing" on the blank canvas, all the colors are inverted by default, until you uncheck the inverse color button. This is done to allow you to write with a black pen or pencil on a white canvas. Next, the pencil tool was used to create a green free-hand string for the balloon.

10.2 Change Fill Pattern

When in Stitch Mode, click the Fill scroll arrow on the stitch toolbar to open the pattern selection drop-down list. A bitmap of the presently selected pattern (the one showing in the edit box) will be displayed. Use the up and down arrow keys to scroll through the list of available pattern fills. Every time a new pattern is selected (highlighted in blue), its bitmap will be displayed next to the drop-down box. To select a pattern to use for filling, click on it. This will close the list and the name of the selected pattern will appear in the edit box.

If you decide at any time to change the pattern for a region (color stop) of the image, you may either directly edit the stitch list entry for the color stop number associated with the pattern. Alternatively, you may re-click on the pattern after you have selected a new fill style.

10.3 Change Paint Tool Color

When one of the painting tools (pencil, paintbrush, or paint bucket) is active, its color may be changed in one of several ways:

1. hold down the Control key and click the tool cursor over the part of the image whose color you wish to use
2. click the normal (arrow) cursor on a color on the palette tool bar which appears at the bottom of the screen when one of the paint tools is active
3. click the "eye dropper" button. This will cause the cursor to change into an eye-dropper when you are over the image, and click the eye-dropper on the color you wish to use

For the paint bucket tool, you can mix a custom color with the color picker tool.

10.4 Remove Speckles

Most raster images - represented by formats such as *.bmp, *.jpg, *.gif, *.png, *.tif - will require some image processing before they are suitable for sewing a high-quality embroidery file pattern.

Most vector images - represented by formats such as *.emf, *.eps, *.wmf - already have performed some type of image processing and may only require minimal processing before being sewn.

What determines when an image is suitable to be sewn? The simple answer is that all the visible (large-scale) colored regions are comprised of single colored pixels and there are very few (or no) speckles in the image.

What are speckles?
Digitized images very often display some color aliasing at boundaries between different colored regions. This aliasing effect introduces a mixture of differently colored pixels in a thin (usually only a few pixels wide) boundary region between the different solid colored regions. These pixels - referred to here as speckles - are generally disconnected from one another and would lead to a very unpleasing sew-out if they were each stitched separately. (The needle would skip around from speckle to speckle, rather than sew in a nice smooth solid fill!)

The example in Fig. 1 is taken from a logo file that was captured and saved with the permission of the embroidery website's owner. Speckles are clearly visible and are due to the image capture process. In addition, there are many hidden speckles not apparent to the naked eye. To view those speckles with SewArt, first reduce the color number if possible (without altering the image quality; in the present example, we choose 15 distinct colors), then click on the merge colors button (see Fig. 2).
Figure 1. JPG image taken from a prominent embroidery website (with permission). Speckles are clearly visible to the naked eye.

Note that there are only five solid areas clearly visible in the logo file (excluding the white background). However, after color reduction there are still 15 colors remaining. This suggests the presence of hidden colors and possible speckles. For example, clicking the sixth color stop button (the salmon color) reveals that it is comprised almost entirely of speckles (Fig. 2). Without further image processing ("despeckling"), this color would produce a disconnected, low-quality embroidery stitch-out due to the numerous (and chaotic) jumps of the needle from speckle to speckle.

To remove these speckles, click the "Despeckle" button while this color is selected. This eliminates (essentially) all these speckles by merging them with the nearest color neighbor(s). This is different than the effect of clicking the "Merge" button, which would change ALL the speckles to a single dominant color. Despeckling is a local operation which will match local speckle color to local neighboring colors and is preferred in this situation. Any remaining speckles can be removed by moving the cursor - which has now become an "eraser" cursor - over them and left-clicking the mouse to erase them.

This process can be applied to all color stops until either the stop has been merged with another color (hold down the Shift key while clicking a color to be merged; then it will be merged with the next color that is clicked) or despeckled. Remember that the Undo (Ctrl-Z) operation can be applied at any time to remove an unwanted merge or despeckle operation. Alternatively, the "Merge Range" and "Despeck(le) Range" buttons can be used to merge or despeckle groups of color stops satisfying certain image area-coverage criteria. For example, all buttons with area coverage less than 0.50% could be despeckled with a single click in this way.

Figure 2. In Merge Mode, clicking on the sixth color stops shows the (hidden) speckles associated with that color.

Alternative methods to eliminate speckles

The Merge Mode operations of Merge and Despeckle offer the greatest control over individual colors and how they are processed.
There are at least two other methods for eliminating speckles. One is to use the image processing wizard, which includes speckle removal as part of its step-by-step guided processing. Another is to use the image Posterization toolbar command.

10.5 Resize or Change Density

After you create an embroidery file with SewArt, it is possible to change the size, stitch density, fill pattern and/or angle.

Important note: If you want to preserve the stitch order of a previously-sewn pattern, **do not** resize the image file (or the stitch list will be cleared!) It is much easier to resize the pattern when you save it (as described below). Here is the simple procedure for editing the embroidery file:

Reopen the image file and click the "Convert" (sewing-machine) icon on the main toolbar. This will get you into Stitch mode. You have the option at this time to reload the previously stitched embroidery file associated with the image. Then follow the directions for editing the stitch list, which are given in the Conversion section. In particular, to change the density just change the value of the separation settings. If you want to change the separation values for all the color stops, it might be easier to clear the stitch list, set the desired separation value on the sewing toolbar, and then resew the entire pattern. Finally, click the File/Save As menu item. Here is where you can choose to resize the pattern sewn, by entering a scale factor value (1.0 means no resizing, 2.0 means double the size, 0.5 means halve the size, compared to the nominal image size).

In addition, you may edit the embroidery file in a separate embroidery file editor.

10.6 Transparency Color

To avoid sewing the background, use the bucket fill tool to flood the background part of the image with a transparency color that will not be sewn. Use the interactive color mixing feature of the bucket fill to select a unique color not in the image pattern. Alternatively, if you have checked the Auto-sew Image box on the Stitch Toolbar, then a drop down list will appear that allows you to chose either to sew all colors or to click on an image color that will be treated as transparent (not sewn).

Otherwise, simply avoid clicking on the background color and it will not sew-out. If you click it by mistake, you can delete it from the stitch list before the embroidery file is written and saved.

11. Toolbars

11.1 Main Toolbar

The main toolbar (shown below) is displayed across the top of the application window, below the menu bar. The toolbar provides quick mouse access to many image-processing and stitching tools available in SewArt.

Many of the toolbar buttons are also toggle buttons. That means they are **mutually exclusive**, so that **only one** of these buttons can be **active** (pressed-in) at the same time. Thus, when you click one of them, and another button in this group is already pressed-in, then that button will be cleared first before the new button becomes active.
To hide or display the main toolbar, choose Toolbar from the View menu (or press ALT+V, T).

**Click**  **To**

Open a new empty blank canvas.

Open an existing image file. **SewArt** displays the Open dialog box, in which you can locate and open the desired file.

Save the active image and stitch file with its current name. If you have not named the image, **SewArt** displays the Save As dialog box. If you are in stitch-mode, then the embroidery file and stitch-list file will be saved instead.

Save the active image and stitch file with a new name by displaying the Save As dialog box.

Cut the part of the image inside the selection rectangle.

Copy the part of the image inside the selection rectangle, to be dragged and dropped elsewhere.

Paste the image file stored in the Windows clipboard into the active window.

Undo the previous operation.

Rotate image

Reflect (mirror) image

Resize image

Crop Image (remove parts of the image not included in stitch pattern)

Posterize an image (reduce colors and speckles)
Start the image-processing wizard.

Reduce number of colors in image

Merge and despeckle colors in image

Paint brush to fill parts of an image with a solid color

Pencil to fill individual points or lines in the image

Paint bucket to fill large regions of the image uniformly

Eraser to remove parts of the image

Add shapes to the image

Convert image to redwork

Opens stitching mode to convert a graphics image to an embroidery file.

About SewArt.

Context help for individual selected items.

**11.2 Palette Toolbar**

The palette toolbar (shown below) is displayed automatically appears across the bottom of the workspace window (above that status pane) when the drawing and fill tools are in use. The toolbar provides quick mouse access to a small palette of colors that may be chosen by clicking on the associated button. Custom colors may also be mixed by clicking the Custom button.

**11.3 Status Bar**

The status bar (shown below) is displayed across the bottom of the application window. It provides information about the pattern being displayed in SewArt, as well as containing a zoom control for changing the on-screen size of the image.
The left area of the status bar previews actions associated with menu items (as you navigate through menus) or toolbar buttons as you “flyover” them with your cursor. The right part of the status bar indicates information about pattern properties:

<table>
<thead>
<tr>
<th>INDICATOR</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLICATION STATUS</td>
<td>Shows status of selected menu or toolbar button, or prompts for Help</td>
</tr>
<tr>
<td>ZOOM</td>
<td>Shows and adjusts zoom factor of pattern (100% indicates the original size of the pattern is displayed)</td>
</tr>
<tr>
<td>WIDTH</td>
<td>Shows width of pattern</td>
</tr>
<tr>
<td>HEIGHT</td>
<td>Shows height of pattern</td>
</tr>
<tr>
<td>COLORS</td>
<td>Shows the number of colors in the pattern</td>
</tr>
</tbody>
</table>

### 11.4 Stitch Toolbar

The stitch toolbar is displayed across the top of the workspace when *Stitch Mode* has been activated by pressing the *Convert to Stitches* button on the main toolbar. There are two types of stitch toolbars described below which appear depending on whether the mode is for filling or outlining the image.

#### Stitch Mode Toolbar

This bar is split into two separate toolbars (see Fig. 1). One of the bars displays tools for editing pattern properties (like underlay, fill, outline or appliqué style), while the other has tools for setting stitch properties (such as separation - lower separation implies higher density - length and angle). Both bars can be moved to other positions in the workspace window by left-clicking and dragging the grab-bar at the left of the toolbar.

These toolbars provide quick mouse access to features used to sew out the pattern file corresponding to the current image in the *SewArt* workspace. The drop-down combo box shown in the top toolbar changes content depending on the *stitch style* that is selected.

![Figure 1. The SewArt stitch-mode toolbar](image)

#### Stitch Styles

The various stitch styles are selected by clicking on one of the four radio buttons on the stitch mode toolbar:

- Fill
When the Fill button is checked (as shown in Fig. 1), then the combo box contains the pattern fill styles that are available for solid pattern fills (see Fig. 2). Click on the down scroll arrow to open the combo box. Use the mouse or the Up/Down Arrow Keys on your keyboard to scroll through the list of available patterns and to display an image of the pattern. In Fig. 2, the diam01 pattern (#19) is highlighted by pressing the Down arrow key, and the pattern appears to the right of the combo list. Once the desired pattern is found, click on it with your left mouse button to select it and close the combo list. You may also print a catalog of all the stitch patterns by clicking the File/Print Patterns menu item. You may create additional fill patterns or edit existing ones with the PAS editor.

Figure 2. Fill stitch pattern combo box

• Variable-Width Satin

When the Var-Satin button is checked, a smooth, variable-width satin stitch will be entered for the next selected colors. The editor shown in Fig. 3 will open when the next pattern color is clicked:
**Figure 3. Variable-width satin fill editor**

The original pattern (in green) as well as boundary contour points (in red) are displayed in the editor. By clicking on the boundary points, satin stitches fill the pattern (light green straight lines). Detailed help for this editor is available by clicking the "Help" button on the editor toolbar.

- **XStitch**

When the XStitch button is checked, the fill becomes cross-stitches. The separation and angle options control the layout of the cross-stitch pattern (see Fig. 4). The pattern labelled "1" has a separation of 1.2 mm and angle 0, and the pattern labelled "2" has a separation of 2.4 mm and angle 45.
Figure 4. Cross-stitch patterns.

- **Outline**

When the Outline or one of the Appliqué button is checked, the second row of controls on the stitch toolbar automatically changes to the outlining toolbar shown in Fig. 5. Note that the Angle scroll and underlay options are hidden in this mode. The Satin Height and Length controls on this toolbar are used to change the properties of the satin outline (or appliqué) stitch (shown schematically in Fig. 6).

![Figure 5. The outline toolbar.](image)

**Figure 5. The outline toolbar.**

![Figure 6. Dimensions of the satin outline/appliqué stitch.](image)

**Figure 6. Dimensions of the satin outline/appliqué stitch.** "H" (height) is the half height (for satin and bean stitches) and "L" (length) is the stitch-to-stitch running length.

For outline stitches, the border (or centerline) of the color region is used to place the stitches. Use the Centerline option to outline thin lines. Otherwise, use the Border option.

- **Outline (Border or Centerline)** When Outline is checked, the combo box fills with several outlining stitches (Running, Bean, Satin). Scrolling through the combo list with the up/down arrow keys will give depictions of the stitch types. In Outline mode, the Angle control becomes inactive.

- **Appliqué (Border)** The border appliqué style saves three separate color blocks when it is sewn. (In SewArt only one color stop appears in the thread list to represent all the appliqué stitches). The first color block is comprised of a loosely-stitched running stitch border used for placing the appliqué pattern cutout material. After that block is stitched, the material can be placed on the fabric inside the indicated border. The next color block is a shorter-length set of running stitches used to tack-down the material. It is stitched in a color that is different from the first and third...
color blocks, to avoid being joined as a single block on some embroidery machines. The final color block is a set of **finish satin** stitches (see Fig. 4) and is sewn in the original color of the image.

The table below summarizes the various buttons and boxes on the stitch mode toolbar, and their functionality.

<table>
<thead>
<tr>
<th><strong>Click</strong></th>
<th><strong>To</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill/Outline/Appliqué</td>
<td>Select stitch style (pattern fill, outline or appliqué stitches)</td>
</tr>
<tr>
<td>Fill/Outline Combo Box</td>
<td>Open a drop-down combo box for selecting pattern fills or outline stitches</td>
</tr>
<tr>
<td>Underlay Check Box</td>
<td>Add (checked) underlay stitch to the pattern</td>
</tr>
<tr>
<td>Auto-sew Color</td>
<td>Automatically sew ALL the same colors (as the one clicked) in the image</td>
</tr>
<tr>
<td>Auto-sew Image</td>
<td>Automatically sew the entire image.</td>
</tr>
<tr>
<td>Separation</td>
<td>Set the density of the fill (in fill mode), with lower separation translates to higher density. In outline mode, set running separation of satin outline stitch</td>
</tr>
<tr>
<td>Length/Width</td>
<td>Set the average stitch length for underlay. In outline mode, sets half-width of satin stitch</td>
</tr>
<tr>
<td>Angle</td>
<td>Adjust the stitch angle of the fill (horizontal fill corresponds to 0 degrees)</td>
</tr>
</tbody>
</table>

**Redwork-Stitch Mode Toolbar**

This toolbar appears automatically when the *Redwork* toolbar button has been clicked, indicating that the image has been previously converted to outlines or center-lines:

<table>
<thead>
<tr>
<th><strong>Click</strong></th>
<th><strong>To</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Stitch Type Combo</td>
<td>Select either a running, bean, or stitch for the outline</td>
</tr>
<tr>
<td>Separation</td>
<td>Set the average separation for the stitch (in 0.1 mm units)</td>
</tr>
<tr>
<td>Satin Width</td>
<td>Set the half-width for the satin stitch</td>
</tr>
<tr>
<td>Sew Outline</td>
<td>Preview the redwork outline before saving the stitches</td>
</tr>
</tbody>
</table>

**11.5 Satin Toolbar**

The satin-stitch toolbar consists of the four buttons shown above. They perform the following functions when clicked:

- Save the satin stitches, close the editor, and return to SewArt
Remove all satin stitches (start over)

Run the satin stitch stitch emulator

Open the satin stitch help tutorial

11.6 Workspace

The workspace for SewArt consists of the blank area containing the image (see figure below), the main toolbar, the main menu, the title bar, and the status pane.

- Title Bar - displays the name of the image file currently opened in SewArt
- Main Menu - provides drop-down lists of actions (like File/Open, Edit cut/copy/paste, etc.) See the menu commands for more information
- Main Toolbar - provides buttons to click that control various actions for editing and stitching images
- Status Pane - shows information about the file (zoom state, size, number of colors)
12. Sew commands
12.1 Auto Sew Color
Click this button to automatically sew (convert to stitches) all parts of the image with the same color as the next selected (clicked) color.

12.2 Auto Sew Image
Click this button to automatically sew (convert to stitches) all colors in the image. A pop-up will appear with the following options (click on one):

- **Set Transparent Color** - this will set one color (usually the background) that will *not* be sewn during the conversion to stitches. The cursor will become the pencil tool and move this tool to the part of the image with the transparent color and click there.

- **Sew All Colors** - select this option to convert every color in the pattern to stitches

12.3 Fill
Click this radio button to select from one of the various fill stitches available in SewArt to fill the next selected pattern color(s).

12.4 Var-Satin
Click the radio button (below) to use a variable-width satin stitch to fill the next selected pattern color(s).

Click the "Next" (right) arrow on this topic to begin scrolling through the help tutorial for the Variable-Satin stitch editor.

12.4.1 Satin Stitch: Basics
Satin-Stitch is an editor that converts (digitizes) an image into satin stitches. The image is opened by selecting the V-Satin stitch option on the stitch toolbar and then left-clicking on the region to be stitched.
Figure 1a displays an image of an hourglass (black) which was imported into the editor. The editor automatically creates a set of equally-spaced boundary points (shown in red), and an approximate “skeleton” (shown in aqua). These are useful guides for entering the satin stitches. The boundary points can be clicked (with the left mouse button) at four corner points which define a quadrilateral (“quad”) – or a set of adjacent quads - which will be filled with satin stitches. The order in which the quad corner points are clicked dictates the direction that the satin stitches will be entered. The two edges P1->P2 and P3->P4 of the quad indicated in Fig. 1a should be approximately aligned with the direction of the skeleton, since the satin stitches will be sewn perpendicular (normal) to those two edges and hence normal to the skeleton. The clicked corner points are displayed in green in Fig 1a. The editor allows for auto-stitch so that for this case, only the four extreme corner points – and NOT ALL the boundary points in between – need to be clicked. Once the point P4 is clicked, it turns green too and the satin stitches are displayed (Fig. 1b). The boundary points used to automatically create the variable-width satin stitch have also been turned from red to green. The direction of the satin stitching will always be from P1 to P2 (in this case, from top to bottom of the image).

12.4.2 Quad Covering
Fig. 1 Various quadrilaterals

For the purposes of the satin stitch editor, a quadrilateral ("quad") is a simple (non-intersecting) polygon with four edges (sides) and four vertices (corners). Fig. 1 shows several examples of quadrilaterals. The satin stitch editor is based on covering an image with adjacent quadrilaterals defined by four corner vertices, where usually the edge of the next quadrilateral coincides with an edge of the previous one. Once a quad is defined by clicking its four vertices (or two new ones is an edge is shared), the editor fills the enclosed curve with smooth satin stitches.

In Basics, the points P1, P2, P3, and P4 of the covering quad were clicked to auto-fill an hour-glass image with satin stitches. The variable width of the satin stitches was automatically accounted for by the editor. It is possible to fill complex figures in more than one way. For example, instead of clicking on the four corner points, one could equally-well fill the hour-glass figure by clicking on a series of adjacent quad vertices, as shown below in Fig. 2. (The actual quads are shown, rather than the clicked vertices). This method, although more time consuming, sometimes affords more control over the smoothness of the final satin fill. In both cases the vertex points are clicked starting from the top left point in a counter-clockwise direction. The figure with the 2 quads shares an edge (in the middle, where blue and green quads touch) so for the bottom quad, only two additional vertices were clicked to complete that quads.
Fig. 2 Covering the hourglass with one quad (left) or two adjacent quads (right).

Note that the rectangular quad on the left actually "covers" the underlying image, in the sense that if it filled (with a color), then the entire image would be invisible (covered). In contrast, the two quad covering on the right only partially covers the image, but the auto-fill property of the editor would complete fill the upper and lower parts of the image with satin stitches bounded by the image boundary points (in red) and not the quad boundaries (dashed lines).

In the case of a curved image, such as the "S" shown in Fig. 3, it is actually necessary to cover the image with several quads in order to render a smooth fill that remains inside the image boundary.
In the left of the figure, the four quad points (P1 - P4, clicked in that order to follow the skeleton) result in a satin fill which is only normal to the curve at the two end faces, and actually "leaks" of the curve boundary. To remedy this, the additional curve points P1-P14 were clicked (in that order) resulting in a satin fill which is almost everywhere normal to the boundary and stays inside the image boundary. Note the points were chosen so that the result quad faces are normal to the image boundary. Also, additional quad edges are placed whenever there is a significant change in the curve skeleton direction (a rule of thumb is a 90-degree change is significant). For example, the vertex pairs (P2,P3), (P5,P6), (P7,P8), (P9,P10), (P11,P12) were all placed where the skeleton direction changed by about 90 degrees.

12.4.3 Edit Stitches
If a point or quad is entered and leads to an unacceptable satin stitch, then you can undo the last point by right-clicking (anywhere on the image), or the entire last quad of points (4) by Ctrl+Right-clicking. The "Remove All Stitches" button on the toolbar can be clicked to remove all points and quads.
The letter "C" from the Britannica alphabet provides an example of a variable width, smooth (curved) image which is open (that is, it does not close upon itself). Unlike the hourglass, more than just four corner points are now required to smoothly fill it with satin stitches. We start with a small segment of the "C" (points P1, P2, P3 and P4 in Fig. 2a, which “follow” the direction of the skeleton). This yields the partial fill shown in Fig. 2b. Note that line joining points P2 and P3 is close to being normal to the skeleton at the point where it crosses (the skeleton). This leads to a nice, normal satin stitch at that point and all points filled. We proceed to fill the rest of the image in three additional segments as shown in Figs. 2c-e. Since each segment is adjacent to the preceding one, it is only necessary to click two points (P5-P6, P7-P8, P9-P10) to add the next
segment (rather than all four points, since they “share” the preceding edge points). This cuts the fill time by a factor of 2.

Note that a total of 10 mouse clicks is all that is needed to fill this “C” with smooth satin stitches.

12.4.5 Closed Curve
The letter “O” from the Britannica alphabet (or any alphabet) provides an example of an image which closes upon itself. It is similar to the “C” open curve example, except that the last unstitched quadrant (see Fig. 3a) now ends by “touching” the first quadrant. Since the end points are same as the start points, which are already green because they were clicked to start the fill, they must be treated specially by clicking all four points to end the fill. That is, instead of JUST clicking P1 and P4 which are already green, one has to click P7->P1->P4->P8 to complete the stitching (see Fig. 3b). The points P1 and P4 turn dark green to indicate they have been clicked more than once.
12.4.6 Angles (Bends)

Until now we have only considered images with smooth curves and no sharp angles or bends. The letter “E” affords an example of an image with bends and requires special treatment and the 4 corners labelled 1-2-3-4 in Fig. 4a. We start by filling the top leg from the right until the corner 1 (Fig. 4b).

The corner (1) is different than any of the figures that have been (auto-) filled insofar as the red contour points only complete the outer part of the figure, but there are none either on the inner vertical or horizontal legs. The auto fill would fail in this situation unless the Ctrl-key is held down to fill the rectangle (Figs 4c-d). Also there are now two satin fill options – either a horizontal fill (Fig 4c) or a vertical fill (Fig 4d) depending on the order in which the corner points are clicked. (We prefer the horizontal fill.) A blow-up of the stitch click order is shown in Fig. 4e. Note that the edges (P1->P2, P3->P4) must be clicked in the directions shown so that the resulting satin stitches will be stitched from top to bottom and connect smoothly to the next stitch block. Also, P1 must overlap the previously-clicked quad end point.
Next, we continue stitching down to the middle “leg” as shown in Fig. 4f, again overlapping the next start click point with P2 in Fig. 4e. Then - holding down the Ctrl-key – the middle leg is stitched. Finally, the rest of the vertical part is completed and the bottom leg is stitched (Fig 4g).

12.4.7 Overlapping Points
The triangle shape in Fig 5a – with three sides and three corners – can not be filled with a quadrilateral (four-sided shape). However, the satin fill can be easily performed by clicking the three corners P1, P2, P3 and the re-clicking P1 as the “fourth” point. The result is the satin fill shown in Fig 5b.
12.4.8 Complex Shapes - Branching

Consider the image below in Fig. 6a, which shows the edge contour points in red and the skeleton in aqua (different background colors will show the skeleton in a different color). It is a "complex shape" because there are several "branches" in the skeleton which have to be "followed" in order to fill it entirely with satin stitches. Three skeleton branch points are labelled "A", "B" and "C" in Fig. 6a (there are many more).
The guiding principle to fill a complex shape with branches is to click contour points (in red in Fig.6a) which approximately follow the skeleton until a "split", or juncture, occurs. The remaining parts of the image can then be filled by following one of these branches until it either branches again or terminates. Once this branch is completely filled, one returns to the original branch (by clicking on one of its edge points) and then follows the remaining unstitched branch(es).

- **IMPORTANT RULE OF THUMB** - always complete filling a branch before returning to the original branch point to start filling another branch. This allows for a smooth fill of the image without any jumps between branches.

To demonstrate the process, the image is filled up to branch point A (Fig. 6b) by clicking the contour points P1 - P4.
Next, start filling the branch to the left by clicking the points P1’ - P4’ in Fig. 3 (note that P1’ overlaps P2 from Fig. 6b). The choice of the branch to follow is arbitrary - we could have chosen to fill the branch going upward. At this point we would continue to fill the remainder of the left branch and all its sub-branches, in a similar way. (For the purposes of this demonstrate, we stopped filling this branch.)
Now apply the rule of thumb and return to the original branch point by clicking on \( P_1'' = P_1' \) (in Fig. 6c) which is \( P_1 \) in Fig. 6b. Complete the quad by clicking \( P_2'', P_3'', \) and \( P_4'' \) in that order (see Fig. 6d). Continue up to the next branch point ("C" in Fig. 6a) by clicking \( P_2'' \) and \( P_3'' \).

Repeat the process at branch point "C" and all subsequent branch points to complete the satin fill.

12.4.9 Disjoint Parts
The lower case letter “j” has a disjoint “dot” on top of the main body. In the context of satin fill, “disjoint” is defined to mean that the skeleton for this image has unconnected parts (the two aqua lines in Fig 6a). The satin stitches for the “dot” are entered by clicking the four top points labeled P1, P2, P3, P4 in Fig 6b. Next holding down the Shift key, point P5 is clicked and the vertical stitches in the lower part of the “j” are completed by clicking P7, P8 and P9 (in that order). The rest of the “j” is then filled with satin stitches in the usual way.

**Fig. 6a**

**Fig. 6b**

### 12.5 X-Stitch
Click this radio button to use a cross-stitch to fill the next selected pattern color(s).

- **X-Stitch**

### 12.6 Outline
Click one of these radio buttons to outline the next pattern that is clicked for sewing.

For thin (existing) outlines, use the Centerline option. Otherwise, to outline a filled region, use the Border option.

- **Outline (Border)**
- **Outline (CenterLine)**

### 12.7 Appliqué (border)
Click this radio button to use a border appliqué stitch for the next pattern color that is clicked (for sewing). You may select one of the outlining stitches (usually bean or satin) for the top stitch.
12.8 Appliqué (centerline)

Click this radio button to use an appliqué stitch, centered on the middle of the pattern, for the next pattern color that is clicked (for sewing). You may select one of the outlining stitches (usually bean or satin) for the top stitch.

12.9 Add Appliqué to Embroidery File

SewArt can be used to add a border appliqué (or satin stitch only) to an existing embroidery file.

If SewArt was used to create the embroidery file from an image file, then just open the image in SewArt and add the border appliqué in the Stitch Mode.

For the case when the original image file is NOT available, it is still possible to add an appliqué (or satin) border to the embroidery file pattern. The steps required to do this are described below, assuming that the SewWhat-Pro editor is used to open the embroidery file and create the image file on the Windows clipboard. (Modifications to this technique using other embroidery editors should be straightforward.)

Step 1: Open the embroidery file in SewWhat-Pro and turn off the grid lines. Select Texture from the View menu so that the image is filled (figure of the black cat below). Make a note of the hoop size used (in this example, the hoop was 100 X 100 mm).

Step 2: From the Edit menu of SewWhat-Pro, click on Copy to place a copy of the embroidery pattern on the Clipboard. If you wish to appliqué only certain color blocks of the pattern, first select those blocks before copying to the Clipboard.
**Step 3:** Open **SewArt.** From the **Edit menu** there, click **Paste** to place a copy of the image file into the **SewArt** workspace.

**Step 4:** To guarantee that the appliqué will fit the original pattern exactly, open the **Resize tool** and enter the hoop size of the pattern from **SewWhat-Pro.** In this example, the pattern copied into **SewArt** from the clipboard was 93 X 93 mm and needed to be resized to the actual hoop size (100 X 100 mm).

**Step 5:** Using the image editing tools (brushes, bucket-fill, etc), make a solid color image of the original pattern (figure at left below). In this example, we filled the image with a solid red color and filled in some of the background separating the main body from the head, paw, and tail.

![Image of a cat pattern with different colors and fills](image)

**Step 6:** Now open the Stitch-Mode window, select the satin-stitch properties, and sew the border appliqué or outline (middle figure above). Save this and merge it with the original embroidery file in **SewWhat-Pro** (figure on the right above). Note how the appliqué fits around the original design exactly, due to the calibration in **Step 4.**

**12.10 Underlay**

Check this check box to add underlay stitches to the next fill pattern that is sewn. Underlay is only applied for area fill and not for outlines or appliqués.